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cc:
RE:

2015 GROUNDWATER LEVEL BASELINE REPORT – NORTH STAR NATURE PRESERVE

1.0

INTRODUCTION

This memorandum describes results of the baseline groundwater information collected for the North
Star Nature Preserve (North Star). The baseline surveys were completed to provide Pitkin County Open
Space and Trails (OST) with the resource information necessary to create a new adaptive management
plan for the property. This report will help enable OST to make sound land management decisions for
North Star based on empirical data and professional judgment.
In 2014, a project team was selected by OST to conduct new baseline biological and
fluvial geomorphological surveys of North Star. This team was composed of wildlife ecologists (Colorado
Wildlife Science, LLC), plant ecologists, wetland hydrologists, and fluvial geomorphologists (Golder).
Biological and fluvial geomorphological surveys were completed on North Star from June through
September 2014, and wetland hydrology analysis was carried out during the 2015 season. North
Star is located in unincorporated Pitkin County, Colorado approximately 1.5 mi southeast of
downtown Aspen, Colorado in Sections 17 and 20 of Township 10 South, Range 84 West of the 6th
Principal Meridian and lies within the North-Central Highlands and Rocky Mountain Section of the
Southern Rocky Mountains Steppe – Open Woodland – Coniferous Forest – Alpine Meadow
Physiographic Province. The 247 ac North Star is composed of two parcels of land – 169 ac North Star
Preserve (acquired in 1978) and 78 ac James H Smith North Star Open Space (acquired in 2001).
North Star is situated near the terminus of a wide, low-gradient valley, which was created by the
retreating Roaring Fork Glacier at the end of the Pleistocene (approximately 11,000 years ago).
The glacier’s moraine deposits acted as a dam that accumulated a thick deposit of alluvium
consisting of glacial outwash and lake and stream sediments to a depth of more than 300 ft. The
stream channel of the Roaring Fork River, a 5th order perennial stream, developed a highly sinuous
pattern due to low gradient and deep deposits of soil. These channel characteristics in combination
with native riparian vegetation and beaver activity enabled elevated annual flows from snowmelt to
overbank and spread across the riparian zone. The Roaring Fork meanders northwesterly through
the entire length of the property. Wetlands and wet meadows occur across much of the
valley supported by riverine hydrology,
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subirrigation, and surface water runoff from adjacent slopes. Vegetation is composed largely of a variety
of montane shrublands, isolated stands of aspen and conifer forests, mixed-mesic grasslands, and
wetland and riparian habitats. The property provides habitat for a diverse array of vertebrates including
economically and culturally important species such as Rocky Mountain elk (Cervus elaphus nelsoni) and
species of conservation concern such as bald eagles (Haliaeetus leucocephalus) and great blue herons
(Ardea herodias).
OST engaged Golder in 2015 to collect baseline groundwater data. The methods and results of the study
are provided in this memorandum.

2.0

BACKGROUND

Golder conducted a groundwater analysis to provide baseline groundwater level information to support
the improvements on North Star. As described in the introduction, North Star encompasses significant
wetland and riparian areas as well as important wildlife habitat. The primary goals of the restoration are
to:


Retain more water on the preserve;



Remove or modify unnecessary head gates by securing them at their maximum
elevation;



Modifying the superficial channels within the floodplain to assist in the rehydration of the
North Star meadows;



Installing low-impact check dams and partial infilling of lateral channels; and



Better understanding the implication of potential new projects on adjacent properties that
may have influence on site hydrology.

One of the goals of the project is to stabilize and enhance the groundwater table on North Star, which is
critical for maintaining wetland habitat. In order to provide a measurement tool to evaluate the success of
the restoration projects and provide valuable information as to whether additional restoration work is
warranted, a groundwater monitoring program was implemented in 2015. The purpose of the groundwater
monitoring in 2015 was to establish a sound baseline for the current conditions of the groundwater table
within the North Star Nature Preserve. As the improvement projects are implemented, changes to the
groundwater regime will be recorded.

3.0

CLIMATE

The vegetation and water regimes at North Star are influenced by the climate near Aspen, CO. Typically,
the area is snow covered from about November through March and only June through September are
warm enough to foster growth (Pitkin County, 2000). Aspen had less precipitation than normal during the
first quarter of 2015 followed by much higher than normal precipitation months in May and July, as shown
in Figure 1 (climate station locations shown in Figure 2).

I:\14\1400717-15\0100\0122\002 TM01 RevA \140071715 002 TM01 RevA 2015BaselineGW Level 07JAN16.docx

Monthly Precipitation (inch)

Gary Tennenbaum
Pitkin County Open Space and Trails

3

January 7, 2016
140071715 002 TM01 RevA

5.0
4.5
4.0
3.5
3.0
2.5
2.0
1.5
1.0
0.5
0.0

Aspen Pitkin Co Airport Sardy Field 2015 Precipitation
Aspen Pitkin Co Airport Sardy Field Normal Precipitation
Aspen 1 SW, CO US 2015 Precipitation
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Figure 1: 2015 Precipitation Records (from National Oceanic and Atmospheric Administration)

Figure 2: NOAA Climate Station Locations

As a result of the higher than average precipitation in May, 2015, much of North Star remained flooded
through June. Accordingly, most of the field work planned in 2015 began in July, including the baseline
groundwater level assessment. Pictures of the property in June 2015 are shown in Figure 3 and Figure 4.
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Figure 4: North Star Preserve showing Seasonal
Flooding – Photo 2

GROUNDWATER MONITORING METHOD

A groundwater study was conducted in 2000 by McLaughlin Water (McLaughlin) as part of a water rights
assessment. McLaughlin recorded groundwater levels in 21 shallow wells located on the North Star
property. The locations of the wells are shown in Figure 1 of Attachment 1. Golder used the same wells
for the 2015 groundwater monitoring.
Golder visited the North Star four times in 2015 to collect groundwater data, with each well visited a
minimum of two times. Golder installed four (4) Level Troll Data Loggers to measure groundwater levels
as well as taking manual measurements. The manual measurements were taken using a water level tape,
which is a measuring tape that sounds an alarm when the probe reaches the water level. Due to the late
timing of installation of the loggers and an error with the instrumentation, only a short period of continuous
measurement was collected in 2015. The loggers were removed on November 14 for winter (due to the
potential of freezing). Golder recommends that the loggers be re-installed in the spring of 2016 and has
provided measurement protocol in Attachment 2. Future monitoring recommendations are discussed in
Section 6.0.
In addition to the groundwater level measurements, Golder also installed the missing well caps on six of
the wells during the November site visit.

5.0

RESULTS

As mentioned in Section 4, Golder visited North Star to collect groundwater levels four times in 2015. One
measurement was also taken at C1 during a vegetation survey on July 29, 2015. The information
collected included the distance from the ground to the highest point of the well casing, the total depth of
the well, and the distance from the highest point of the well casing to the groundwater. The
measurements are shown in Table 1 and discussed in the following section.
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Table 1: Groundwater Measurements 2015

8028.5

1.72

4.94

4.50

-

D3

8027.0

0.96

4.93

2.50

-

C6

8026.1

0.90

5.91

2.42

C10

8024.7

2.23

7.19

D10

8030.0

2.72

MWE3

8015.1

B23

8/1/2015

11/7/2015

D4

Well
ID

7/29/2015

Depth of
Well
from
Cap (ft)

7/16/2015

Ground
Elevation
(ft)

Distance
Well Cap
is above
Ground
Surface
(ft)

11/14/2015

Measured Distance to Groundwater from top of well
(ft)

Dry or
frozen

Dry or frozen

2.63

2.76

2.79

-

-

5.33

5.3

3.80

-

-

6.45

6.49

10.60

6.75

-

8.74

10.01

10.03

0.00

4.90

Dry

-

Dry

Dry

Dry

8007.2

2.49

6.94

4.61

-

-

-

MWE1

8006.9

1.55

-

4.42

-

-

-

MWE2

8005.1

1.68

-

4.59

-

-

-

6.73
Unable to
locate (snow)
Unable to
locate (snow)

B20

8005.8

2.33

6.92

5.28

-

-

-

Dry or frozen

B9

8020.4

2.37

7.95

5.65

-

-

6.78

7.48

B7

8021.1

1.63

6.96

-

4.59

5.51

5.45

B6

8021.2

2.13

4.90

-

-

3.35

3.24

B4

8021.8

0.00

4.37

3.73
GW at
surface
GW at
surface

-

-

2.76

B3

8020.9

0.79

-

2.35

-

-

-

2.71
Unable to
locate (snow)

B2

8021.7

1.51

5.92

2.76

-

-

-

5.25

B1

8022.0

1.53

10.02

3.58

-

-

-

5.05

A1

8026.2

0.83

2.90

1.94

-

-

-

Dry or frozen

A2

8033.5

0.63

3.39

1.44

-

-

-

2.00

C1

8022.2

1.06

6.01

-

2.68

3.87

5.32

4.95

A3

Not located

D2

Not located

The results are grouped into four geographical regions, as shown in Figure 1 of Attachment 1. The first
region includes D3, D4, and C1, located around the wetland. The groundwater level in D3 and D4 show
very little change throughout the year, which is consistent with the results from the study conducted in
2000 (McLaughlin, 2000). The wells D3 and D4 are 4.0 and 3.2 ft deep, respectively. Well D4 was dry or
frozen when visited in November. C1 is about 5.0 ft deep and is located north of the wetland. The water
levels in C1 decreased about 2.3 ft from July to November. This is likely due to groundwater recharge
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from runoff and snowmelt from the hill slopes adjacent to the valley and the high precipitation resulting in
flooding in May and July 2015, followed by typical, seasonal decreases in the water table in September
through the winter months.

8027

Well was dry during November Visit

Groundwater Elevation (ft)

8026
8025
8024
8023
8022
8021
8020
8019
8018

D4

D3

12/2/2015

11/18/2015

11/4/2015

10/21/2015

10/7/2015

9/23/2015

9/9/2015

8/26/2015

8/12/2015

7/29/2015

7/15/2015

7/1/2015

8017

C1/C2

Figure 5: Groundwater Levels D3, D4, and C1

The second region includes the wells located adjacent with the northern portion of the Roaring Fork River
on the North Star property, as shown in Figure 1 of Attachment 1. The wells in this region include A1, A2,
B1, B2, B3, B4, B6, B7 and B9. The results from these wells show a similar trend, with decreased
groundwater elevation by about 1.5 to 3.4 feet from July to November for the wells on the west side of the
Roaring Fork River. A1 decreased by at least 1 ft and A2 decreases by about 0.6 ft, located on the east
side of the Roaring Fork River. The water level was at the ground surface in wells B4 and B6 during the
July visit. B7 was the only well from this region visited on both July 16 and August 1, and shows a steeper
decrease in groundwater levels in July with the water table stabilizing later in the year. This trend was
also observed in the 2000 groundwater study. The results are shown in Figure 6.
It appears the well B2 was damaged, possibly by a vehicle. The well case above the ground is bent.
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8034
Distance to Groundwater (ft)

8032
8030
8028

Well was dry during November visit

8026
8024

Water at surface during July visit

8022

Well was burried in snow during November visit

8020
8018
8016

B4

B2

B3

B1

A1

12/2/2015

11/4/2015

10/7/2015

9/23/2015

9/9/2015

8/26/2015

8/12/2015
B6

11/18/2015

B7

10/21/2015

B9

7/29/2015

7/15/2015

7/1/2015

8014

A2

Figure 6: Groundwater Levels B1, B2, B3, B4, B6, B7, B9

The third region described in this study includes C6, C10, and D10. The groundwater elevation in this
region decreased by 2.9, 2.7 and 3.3 ft, respectively. Again, the change is likely due to groundwater
recharge from runoff and snowmelt from the hill slopes adjacent to the valley in the spring followed by
seasonal decreases in late summer through winter. The results are shown in Figure 7.
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Groundwater Elevation (ft)

8027
8026
8025
8024
8023
8022
8021
12/2/2015

11/18/2015

D10

11/4/2015

10/21/2015

C10

10/7/2015

C6

9/23/2015

9/9/2015

8/26/2015

8/12/2015

7/29/2015

7/15/2015

7/1/2015

8020

Figure 7: Groundwater Levels C6, C10, D10

Finally, the last region includes the wells located at the southern portion of North Star. Most of these wells
were visited in July, and were either dry or buried in snow during the November visit. Similar to the wells
described above, the groundwater level decreased in B23 by 2.1 ft and in B20 by at least 1.6 ft (measured
to the bottom of the well) from July to November. The results are shown in Figure 8.

Groundwater Elevation (ft)

8005.5
8005.0
8004.5

Well was burried in snow during November visit

8004.0
8003.5
8003.0

Well was dry during November visit

8002.5

Well was burried in snow during November visit

8002.0

Figure 8: Groundwater results B23, MWE1, MWE2, B20
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2016 RECOMMENDATIONS

Golder recommends continuing to collect groundwater data to build on the baseline data collected in 2000
and 2015. The groundwater levels from the 2015 study were consistently about 1-3 feet above the levels
measured in the 2000 study, showing the importance of multi-year data collection. As illustrated in
Section 5, most of the localized wells show similar groundwater trends (recharge and discharge), and
therefore, it may not be necessary to monitor all 20 wells in the future. Based on Golder’s experience
gained in 2015, we recommend continued monitoring on a minimum of the following wells: D3, C1, D10,
B7, and potentially B23. Monitoring protocol is provided in Attachment 2.
Continuing to collect baseline information for multiple consecutive years will provide the information
necessary to evaluate the positive benefits for the planned improvement projects. Monitoring the
groundwater and showing how the improvement efforts have enhanced the groundwater table around the
wetlands can also be used to educate the public on the importance of the on-going North Star restoration
projects.
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ATTACHMENT 1
GROUNDWATER MONITORING WELL LOCATIONS
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ATTACHMENT 2
SIMPLIFIED MONITORING PROCEDURES

LOCATE THE WELLS AND DO A VISUAL INSPECTION
Many of the monitoring wells are located in deep grass or snow. Therefore, locating the wells is easiest
with a GPS. The GPS coordinates are provided in Figure 1 of Attachment 1. It is recommended that
fiberglass rods or lath be installed next to each well in 2016, on a consistent side (e.g. north side).
Do a visual inspection of the well and make notes of any damage or changes to the well (i.e. missing cap,
impact damage to the casing, casing sitting at an angle, etc.).

MANUAL MEASUREMENTS
Manual measurements of the groundwater level should be made on a monthly (not less than quarterly)
basis, using a water level tape. The water level tape is a measuring tape that sounds an alarm when the
probe reaches the water level and will look similar to the one shown in the figure below.

Lower the probe into the well until it sounds an alarm. Carefully determine the water surface by slowly
lowering and raising the probe at the air/water interface. The measurement should be taken from the top
of the highest part of the well casing (in the locations with double casings, use the highest one).
Record the data both on a datasheet (while in the field) and on the spreadsheet (in the office).
The water level tapes can also be used to measure the full depth of the well. This is accomplished by
lowering the probe until it touches the bottom and the tape becomes slack.
The instruction sheet for the water level tape is appended to these instructions.

SIMPLIFIED PROTOCOL FOR LEVEL TROLL 400 DATA LOGGER
Four level troll loggers were purchased from In-situ (https://in-situ.com/) in 2015 to be used to monitor
groundwater at North Star Nature Preserve. The quick start guide is appended to these instructions and
simplified instructions are outlined below. It is recommended to have a copy of the Operator’s Manual
available (i.e. saved on the hard drive of the field computer). The Operators Manual can be found on the
In-Situ website:
https://in-situ.com/wp-content/uploads/2014/11/Level-TROLL-400-500-700-700h_Manual.pdf
Before going to the Field
1. Win-Situ 5 Software must be installed on the field computer. This software can be
downloaded
from
the
In-Situ
Website
free
of
charge
at
https://insitu.com/support/type/software/
2. Select the appropriate TROLL Com Communication Device – (Laptop with windows 2000
Professional SP4 or higher, or Windows XP Professional SP2 or higher, or Windows
Vista SP1 or higher)
In the field
1. Connect the hardware.


Located in 4 wells



Remove the well cap and carefully pull out the Cable-connect TROLL Com Device.
They are attached by a ring with a screw-lock “D-ring” that can unlock with use.
These are NOT submersible. Be sure not to pull the Level Troll out of its position.



Detach the desiccator and inspect for saturation (indicated by a change from purple
to pink). Note: the desiccators installed in 2015 were pre-used and dried in the
factory. They do not have the original purple color and should be changed for new
desiccators early in 2016 (larger desiccators are available from In-Situ, that should
last an entire season).



Attach the USB Troll Com Cable Connect with the flat side of the connector directly
facing its counterpart in the Cable-connect TROLL Com Device. Lock into position.

2. Open the software and establish communication with the instrument by selecting the
“plug-in” icon on the lower right portion of the screen.

3. Download the log by selecting the download button.



Choose 1 of 3 options: All data, New data (data logged since last download – the
default download), or Time interval to download



To append new data to the last download, select “Append logs on download” under
Preferences > General Settings



At the end of the download you have the option to view the data – select yes or no;
data will be visible in the Data screen.

4. Complete a manual measurement using the water level tape at the time of the download.
The manual measurement will be used to help calibrate the continuous measurement
from the logger.
5. Download the BaroTROLL atmospheric data logger in a similar manner to above.

Innovations in
Water Monitoring

Instruction
TechnicalSheet
Note
Rugged Level Tape 100 and Rugged Level Tape 200
Equipment Check
Test the circuit and battery
1. Press the test button shown in Figure 3, number 5
(see opposite page).
2. If you do not hear a beep, perform the following steps:
a. Tighten the knobs that secure the control panel
(Figure 3, numbers 6 and 7) and retest.
b. Turn the sensitivity knob fully clockwise (Figure
3, number 4) and retest.
c. Replace the 9 V battery in the battery box
and retest.
Test the tape and probe
1. Position the unit as shown in Figure 1.

3. Rotate the hand brake
counterclockwise until the tape
slowly unwinds from the reel.
4. The unit will beep when the
probe touches water. Carefully
determine the depth to water
from the reference point by
slowly lowering and raising the
probe to the air/water interface.
Raise the probe, dry it, and
Figure 2. Hand brake
repeat the measurement.
Note: When measuring wells with cascading water,
rotate the sensitivity knob counterclockwise to
reduce probe sensitivity and eliminate false signals.
5. Rugged Level Tape probes are rated to full depth
and can be used to measure the depth to the
bottom of a well. Slowly unwind the tape until
the probe touches the bottom and the tape
becomes slack.

Figure 1. Testing the tape and probe
2. Place the tip of the probe on the axel stud while
also placing the probe body on the raised screw as
shown. If the tape and probe are working correctly,
you will hear a beep and see the LED light up.
Test the whole unit
1. Dip the probe in a container of tap water. Do not
use deionized or distilled water.
2. If the unit is working correctly, you will hear a beep
when the probe touches water.

Field Use
1. Ensure the knobs that secure the control panel are
tightly fastened.
2. If possible hang the unit on the well casing. Guide
the tape over the tape guide avoiding the edge of
the well casing to prevent damaging the tape.

Important: Do not allow the probe to fall freely to the bottom
of the well because it will damage the probe.
6. As you wind the tape onto the reel, remove
moisture and debris.

Troubleshooting
No sound when the unit is in water
1. Check the battery by pressing the test button.
Replace the battery if it is low (Figure 3, number 1).
2. Tighten the knobs to secure the panel to the reel. If
the unit still does not sound, check all connections
on the control panel.
3. Check the probe conductor to make sure that it is
clean and free of mineral deposits.
4. Inspect the tape and probe for damage.
5. Increase sensitivity.
Continuous sound when the unit is tested out of water
1. Make sure the probe conductor tip is clean.
2. Check for moisture on the back of the control panel.
3. Check the probe/tape connection for damage that
might have allowed water to enter the system.
4. Reduce sensitivity if unit has been used in saline water.

General Guidelines
•
•
•
•

Do not scrape the tape against sharp-edged well casing.
Avoid entanglement with other equipment in boreholes
and wells.
Do not use this unit as a guide for backfilling with sand
because the probe may become trapped.
Rewind the tape onto the reel after each use.

Figure 3. Control panel
1. Battery box

2. Signal LED

3. Signal buzzer

4. Sensitivity knob for cascading
water. Not an On/Off switch.

5. Test button

6. & 7. Panel attachment knobs

Cleaning
1. Always clean the Rugged Level Tape after use to
maintain optimal performance and extend the life
of the unit. Properly clean the unit to prevent crosscontamination between wells.
2. Unwind the tape and wash the tape and probe with a
mild detergent. Rinse well, wipe with a soft cloth, and
rewind onto the reel.
3. Remove the electronics module before washing the reel.
Remove the two knobs that secure the control panel to
the reel. Carefully pull the module out of the reel. Wash
the reel with a mild detergent and dry completely before
reinstalling the module.

Figure 4. Rugged Level Tape 200 installed in well

Important: Do not use abrasive materials, partially halogenated
hydrocarbons or ketones to clean the reel.

ASME certification does not apply to the Rugged Level Tape 100 or the Rugged Slim Tape.

For more information, contact In-Situ Inc.
221 East Lincoln Avenue, Fort Collins, CO 80524
1-800-446-7488 (toll-free in U.S.A. & Canada)
1-970-498-1500 (international & domestic)
www.in-situ.com
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l

Level TROLL® 400, 500, 700, and 700H

A serial (RS232) TROLL Com is required for use
with a RuggedReader Handheld PC.

Connecting the RuggedCable System
Connect the Instrument to the RuggedCable
System
1. Remove the protective caps from the instrument and
cable. Ensure that the O-ring on the instrument
connection is clean.

Connect TROLL Com Communication Device to
the RuggedCable System
1. If a desiccant is present, remove the desiccant from the
cable. Hold the textured section of the cable connector in
one hand and the desiccant in the other. Twist in
opposite directions to unlock the desiccant from the
cable.

2. Locate the flat side of each connector and notice the pins
on the instrument connector and the slots on the cable
connector.
2. Position the TROLL Com and the cable flat edges so
they will connect properly. Insert the TROLL Com
connector firmly into the cable connector.

In order to deploy the instrument, complete the following
steps.
l

l

l

l

l

3. Slide back the sleeve on the cable connector.

Connect the instrument to a computer or
RuggedReader.
Connect the instrument to the software and set up a
site and a data log.
Install the instrument in the water. (If you are using a
level reference set it at this time.)

4. Position the instrument and cable flat edges so they will
connect properly. Insert the instrument connector firmly
into the cable connector.

Verify the installation position then disconnect the
instrument from the computer or RuggedReader.

Field Deployment

Secure the cable and install the desiccant.

Select a TROLL Com Communication
Device
The subsequent figure shows the function and connection
features of the TROLL Com Communication Device
models.
l

l

A Direct-Connect TROLL Com might be preferred
for programming an instrument that will be deployed
on a suspension cable.
A RuggedCable System and a Cable-Connect
TROLL Com are required if you intend to
communicate with the instrument while it is
deployed. However, you can program the instrument
with any TROLL Com.

3. Hold the textured section of the sleeve in one hand and
the TROLL Com in the other. Push and twist until you
hear a click. The click ensures the cable and TROLL
Com are securely attached.

1

Serial port on a PC/laptop and RuggedReader
Handheld PC

2

Cable-Connect TROLL Com Communication
Device, serial connection, for field use

3

Direct-Connect TROLL Com Communication
Device, serial connection, programming only, not
submersible

4

USB port on a PC/laptop

5

Direct-Connect TROLL Com Communication
Device, USB connection, programming only, not
submersible

6

Cable-Connect TROLL Com Communication
Device, USB connection, for field use

5. Slide the cable sleeve toward the instrument until the pin
on the instrument fits into the hole in the slot on the cable
connector.

6. Hold the textured section of the sleeve in one hand and
the instrument in the other. Push and twist until you hear
a click. The click ensures the cable and instrument are
securely attached.

Program the Instrument
In order to set up a log or download data, you must
connect the instrument to a computer running Win-Situ 5
Software, or a RuggedReader Handheld PC running WinSitu Mobile. Refer to the Win-Situ 5 or Win-Situ Mobile
section. See page 2.

Position the Instrument
Place the instrument at the desired depth. Position the
instrument below the lowest anticipated water level, but
not so low that the pressure sensor range might be
exceeded at the highest anticipated water level. Refer to
the tables below to determine usable depth.
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A BaroTROLL Instrument can be deployed
with a non-vented instrument to compensate
level data for changes in atmospheric
pressure. Make sure the clocks on both
instruments are synchronized, and install the
BaroTROLL in a location that will never be
submerged in water.

Secure the Cable

PSIA

PSIA

kPA

Meters

Feet

30

15.5

106.9

11

35

100

85.5

589.5

60

197

300

285.5

1968

200

658

500

485.5

3347

341

1120

1000

985.5

6795

693

2273

4. Remove the red dust cap from the black nylon cap to
allow air to reach the cable’s vent tube.

1. Remove the protective dust cap from the bottom of the
desiccant pack, if applicable.
2. Remove expiring desiccant (if present) from the cable by
grasping the textured section of the cable connector in
one hand and the desiccant in the other. Twist in
opposite directions to unlock the desiccant from the
cable.

Usable Depth

Effective Range

3. Use the attached hook-and-loop strap to secure the
desiccant to the cable, below the stripped wires.

Installing Desiccant with Twist-Lock
Connectors

Non-Vented Level TROLL Instrument
Range

desiccant to effectively keep cables, instruments, and
electrical boards dry until your next scheduled
maintenance. Desiccant life span is dependent on site
conditions.

3. Attach the new desiccant pack to the twist-lock
connector on the cable.

* Effective range for psia sensors is limited by an estimated 14.5
PSI atmospheric pressure at sea level.

1

Outboard desiccant is attached to the cable
vent tube.

2

Desiccant is secured to the cable with a strap.

Safety
Vented Level TROLL Instrument
Usable Depth

Range

1

Well Dock Installation Ring

2

Kellems Grip

3

Instrument Installed in Well

PSIG

kPA

Meters

Feet

5

34.5

3.5

11.5

15

103.4

11

35

30

206.8

21

69

100

689.5

70

231

Desiccant

300

2068

210

692

500

3447

351

1153

Desiccant protects electronics from condensation, which
can cause irreparable damage and loss of data. Indicating
desiccant changes from blue to pink as it becomes
saturated with moisture.

Verify Instrument Depth
After you have installed the instrument, it is possible to
connect the instrument to a computer or RuggedReader,
open the software, and take a reading to verify the
installation position. If the reading confirms that the
instrument is in the correct position, you can secure it as
described below.
During log setup there was an option to "Remind Me Later"
for setting a level reference. If you set the log to remind you
later, ensure that the instrument is submerged and set the
level reference when prompted.

The instrument complies with all applicable directives
required by CE and the FCC and is found to comply with
EN 61326, ICES-003, and FCC Part 15 specifications.
Declarations of conformity may be found in the Operator's
Manual.

Win-Situ 5 Software
Installing Outboard Desiccant
Vented cable must be installed with outboard desiccant to
protect the cable and instrument electronics from
condensation in high-humidity environments.
The desiccant can be removed from the vent tube, if
necessary, to trim the conductor wires. However, you must
reinstall the desiccant after trimming and connecting the
wires.

Desiccant stages (from left)
New, nearly expired (replace now), expired
It is extremely important to use a properly-sized
desiccant for your deployment and to change desiccant
often. Desiccant should be changed before the entire
volume has turned pink, and you should use enough

1. Cut off the knot at the bottom of the vent tube extension.
2. Firmly attach the vent tube extension to the cable vent
tube. Cover at least 6.4 mm (0.25 in.) of the cable vent
tube for a secure attachment.
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Use Win-Situ 5 with a laptop or a PC and the Aqua
TROLL, Level TROLL and Rugged TROLL Instruments.
To learn more about Win-Situ 5, refer to the Help menu.
Training videos are available on the In-Situ Inc. website
www.in-situ.com under Tech Resources.

Install Win-Situ 5
Insert the software CD that came with your product or
download Win-Situ 5 from the In-Situ website at www.insitu.com/software. Follow the on-screen prompts of the
Installation Wizard to complete installation.
IMPORTANT: Install COM drivers when prompted.

Connecting an Instrument to the Software
When you open Win-Situ 5 Software, you are asked if you
want to connect to your device. Click Yes. Synchronize the

instrument clock to the PC clock.
Parameters and measurements are displayed in light gray
on the home screen if a connection is established. Click
the Play button
to view live readings.
The software displays an error message if a connection
cannot be established.

Selecting the Correct COM Port
If you are using a USB TROLL Com, select the correct
COM port by following the steps below. If you are using a
serial TROLL Com, the Win-Situ Software should default
to the correct COM port, which is usually COM 1.
Steps for Windows 8 systems.
1. Right-click the Start screen.
2. Select All Apps.
3. Click Control Panel.
4. Open the Device Manager.
5. Click the arrow next to Ports (Com and LPT), and
locate the USB Serial Port listing. The number listed
next to this entry is your COM port address.

4. Click the plus sign next to Ports (COM and LPT), and
locate the USB Serial Port listing. The number listed
next to this entry is your COM port address.

1. Once you have determined the correct COM port
address in your operating system, reopen Win-Situ 5
Software.
2. Close any open windows in Win-Situ Software.

4. Click Comm Settings, and then click the Port Number
menu.
5. Scroll down to find the correct COM port address. Click
the check mark to accept the changes.

1. Click the Site button.

1. Minimize the Win-Situ Software.
2. Click the Windows Start button, and open the Control
Panel.
3. Double-click the System icon. Click the Hardware tab,
and open the Device Manager.

4. Select the parameters you intend to monitor. You can
rearrange their order and select different units.

6. Configure the logging method.
7. Select a start condition.
When an instrument is deployed on a wire,
rather than a cable, you will not be able to
communicate with it after installation. Select a
Scheduled start if you are deploying an
instrument on a wire.

2. Click the Windows Start button, and open the Control
Panel.

Steps for Windows XP systems.

3. Select your site, and name the new log.

6. Click the yellow Connect button in the lower right corner
5. Select a logging method appropriate for your
to establish a connection to the instrument.
deployment.

Set Up a Data Site

2. Select either Default Site or click the New button to set
up a custom site.
3. Enter a Site Name. Entering coordinates and uploading
a picture are optional.
4. Click the check mark to save the data site.

IMPORTANT: Your instrument MUST be
installed in its final location to set the level
reference correctly. If you are setting up a data
log before installing your instrument in its final
location, you will need to select either “Set First
Logged Reading To” or “Remind Me to Set
Reference Later.”
10. Enter a specific gravity value for the deployment.

2. Click the New button.

3. Click Preferences.

1. Minimize the Win-Situ Software.

4. Click the arrow next to Ports (COM and LPT), and
locate the USB Serial Port listing. The number listed
next to this entry is your COM port address.

1. Click the Logging tab.

The following steps apply for all Windows
operating systems.

Steps for Windows 7 systems.

3. Click Hardware and Sound, and open the Device
Manager.

Set up a Data Log

8. Select a level reference type.
9. Configure the level reference. Select “Set First Logged
Reading To” if you are using a scheduled start, or
“Remind Me to Set Reference Later” if you are using a
manual start and are NOT deploying the instrument on a
wire.

11. The software displays a summary. Review your
selections carefully before clicking the check mark.
12. Start the log. A Scheduled Start log will start
automatically at its programmed time. To start a Manual
log, go to the Logging tab, highlight the log name, and
tap the Start button.

Real-Time Data Readings
To view real-time data readings, click the Start button on
the Home screen. The parameter readings will turn black
and update periodically. Click the Start button again to
stop reading in real time.
IMPORTANT: You cannot create a new log if you
have real-time readings enabled.

Downloading Data to a PC
This procedure copies the data log from the instrument to
a PC. It does not remove the data log from the instrument.
After a log is downloaded, it can be exported to a CSV file
format that can be used by spreadsheet programs. The
time shown in the log name is the time the log was
downloaded.
1. With an instrument connected, select the Logging tab
.
2. Select the log you intend to download.
3. Choose a Running, Suspended, Stopped, or Deleted
log.
4. Click the Download

button.

5. In the next screen, select one of the three download
options.
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l

All data

Connect to the Software

l

New data (data logged since the last download)

l

Time interval to download

With an instrument connected, tap the Start button on the
RuggedReader. Tap Win-Situ Mobile. Tap the Connect
button, and tap the check mark.

3. At the end of the download, Win-Situ gives you the
option of viewing the data.
l

l

3. Add the log name and tap the right arrow button.
4. Select the parameters you want.

Set up a Data Site
1. Tap the Sites button. Select an existing site or tap the
New button to create a new site.

7. Configure the logging method.

When an instrument is deployed on a wire,
rather than a cable, you will not be able to
communicate with it after installation. Select a
Scheduled start if you are deploying the
instrument on a wire.

Win-Situ Mobile Software

9. Select log wrap condition.
2. Enter information on the subsequent screens and
continue by tapping the right arrow button. Tap the
check mark button when finished.

Set up a Data Log
1. Tap the View menu and select Logging.

2. Communication Cable
3. RuggedCable System
2. Tap the More button, and then tap the New button.

Stop a Log
After you stop a log you cannot restart it.
1. To permanently stop a log that has no scheduled stop,
go to the Logging tab, and select the log.

10. Select a level reference type.

2. Tap the More button, and then tap the Stop button.

11. Enter a specific gravity value for the deployment.

3. Make sure that you download the data after you stop a
log.

12. Configure the level reference. Your instrument MUST be
installed in its final location to set the level reference
correctly. If you are setting up a data log before installing
your instrument in its final location, you will need to select
either “Set First Logged Reading To” or “Remind Me to
Set Reference Later".
Select “Set First Logged Reading To” if you are
using a scheduled start, or “Remind Me to Set
Reference Later” if you are using a manual
start and are NOT deploying the instrument on
a wire.

1. Rugged Reader

4. In-Situ instrument

6. Select a logging method appropriate for your
deployment.

8. Select a start condition.

Select No and the Logging screen appears. You
can view the data at any time by selecting it in the
Data tab.

Connect an Instrument to the Rugged Reader
Serial Port

2. To view the data, tap the View button. Use the View
drop-down menu to select the data channel you want to
view. Select the date and time interval you want and tap
the check mark.

5. Rearrange parameter order if desired. Tap Edit to
change units.

Select Yes and the log is displayed in the Data
screen.

Use Win-Situ Mobile with a RuggedReader Handheld PC
and Aqua TROLL, Level TROLL, and Rugged TROLL
Instruments. Training videos are available on the In-Situ
Inc. website www.in-situ.com under Tech Resources.

View or Download the Log
1. To download data, tap the Logging tab, and tap the
Download button. Select the desired download options
and tap the check mark when finished.

New data is downloaded by default to a new
log file. To append new data to the last
download of this log, be sure the option
"Append logs on download" is selected in the
General Settings dialog (Preferences >
General Settings).
2. The log is copied to the connected PC into your Win-Situ
working directory folder. View or change the working
directory using File > Settings.

log, go to the Logging tab, highlight the log name, and
tap the Start button.

13. The software displays a summary. Look over your
selections carefully before clicking the check mark.
14. Start the log. A Scheduled Start log will start
automatically at its programmed time. To start a Manual
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Drop the Connection and Exit Win-Situ Mobile
Software
Prior to physically disconnecting the RuggedReader from
the communication cable, tap the Connect button. The
button changes from blue to yellow and appears
disconnected.
To exit Win-Situ Mobile Software, tap the File menu and
select Exit.

